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chapter 1

Introduction
This guide describes how to use the Avid® 
Interplay™ system to pass sequences and audio 
files back and forth between Avid video editing 
systems and Pro Tools® audio editing and mix-
ing systems.

Avid Interplay Capabilities
Avid Interplay is an asset management system 
that lets Avid editors and Pro Tools editors at a 
single facility manage and work with the same 
media, as follows: 

• Perform workflows on the same video media 
sequentially or simultaneously.

• Choose from multiple workflows for sharing 
files.

• Monitor, manage, and track video sequences.

• Revert to previous versions of sequences.

• View and manage past history on individual 
sequences.
Pro Tools Interplay Option
With the Pro Tools Interplay Option installed, 
Pro Tools editors can interact directly with the 
Avid Interplay asset management system to:

• Check out sequences.

• Edit and mix within a Pro Tools session.

• Export the session and any new media back to 
the sequence on Interplay.

You can also use the Interplay Access and Inter-
play Administrator applications to manage and 
share files directly with an Avid editor.
Chapter 1: Introduction 1
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Overview of Avid Interplay 
Components
This guide addresses working with Pro Tools HD 
within an Avid Interplay system (or workgroup) 
comprising the following components:

• An Avid Unity MediaNetwork™ or Unity 
ISIS™ storage server (where all the media is 
stored)

• An Avid Interplay server, referred to hereafter 
as Interplay (which manages the metadata 
stored on the Unity storage server)

• The following Interplay applications (which 
let users interact directly with Interplay):

• Interplay Access

• Interplay Administrator

• The following software applications (which 
let users check in sequences to or check out se-
quences from Interplay):

• Pro Tools HD with the Pro Tools Interplay 
Option 

• An Interplay-compatible Avid editing ap-
plication

See Chapter 3, “Avid Interplay Workflows for 
Pro Tools and Avid Editing Applications” for a 
detailed diagram of the Avid Interplay environ-
ment described in this guide.

For detailed information on setting up the 
components of an Avid Interplay environ-
ment not addressed in this guide, contact an 
Interplay administrator.
Pro Tools Avid Interplay Guide
Avid Unity MediaNetwork and 
Unity ISIS Storage Systems

Avid Unity MediaNetwork provides high-speed 
fibre channel-based network storage systems for 
Avid and Pro Tools workstations. 

Avid Unity ISIS provides high-speed gigabit eth-
ernet-based network storage systems for Avid 
workstations.

System Requirements
Using the Pro Tools Interplay Option requires 
the following;

• Windows XP

• Pro Tools HD

• Avid editing applications supported by Avid 
Interplay 1.0.3 and higher

• Direct connection to an Avid Unity Media-
Network server

• Avid Interplay Installer DVD

• Configured Avid Unity ISIS or Unity Media-
Network client

For complete system requirements, visit the 
Digidesign website (www.digidesign.com) and 
the Avid website (www.avid.com).

Compatibility Information

Digidesign can only assure compatibility and 
provide support for hardware and software it has 
tested and approved.

For a list of Digidesign-qualified computers, op-
erating systems, hard drives, and third-party de-
vices, visit the Digidesign website
(www.digidesign.com).



                    
About Avid Interplay Guides
PDF versions of Avid Read Mes are installed au-
tomatically with Avid Interplay software. Also, 
searchable online help files containing the same 
information are accessible from the Help menus 
in the Interplay Access and Interplay Adminis-
trator applications.

You can use any of the following guides as sup-
plementary information for this guide.

• Avid Interplay Best Practices Guide contains an 
overview of Avid Interplay as well as task-ori-
ented instructions, conceptual information, 
and reference material needed to use the Avid 
Interplay system. It is intended for all Inter-
play users, from beginning to advanced.

• Avid Interplay Software Installation and Configu-
ration Guide explains overview installation 
and configuration information for the Inter-
play components on the Avid Interplay In-
staller DVD. It is intended for Interplay 
administrators who are upgrading or setting 
up an Avid Interplay system from scratch.

• Avid Interplay Access User’s Guide contains a 
conceptual introduction to help users get 
started, as well as detailed explanations about 
screen views, commands, and processes. It is 
intended for all Avid Interplay end users who 
need to import, find, and access master clips, 
sequences, and other assets in the Avid Unity 
MediaNetwork or Avid Unity ISIS environ-
ment in their daily work. 

• Avid Interplay Engine and Avid Interplay Access 
Administration Guide explains how to install, 
configure, and maintain an Avid Interplay 
system (server and clients, and all related sys-
tem connections and user rights). It is in-
tended for all Avid Interplay administrators 
who are responsible for these tasks.
These guides and other Interplay guides are 
available on the Avid Interplay Online Library 
DVD and on the Avid Knowledge Base 
(http://www.avid.com/onlinesupport). To view 
or print PDF guides, you can use Adobe Reader.

Support for Avid Interplay and 
Pro Tools Interplay Option
For support on Avid Interplay or the Pro Tools 
Interplay Option, visit Avid’s online Knowledge 
Base (www.avid.com/onlinesupport). Online ser-
vices are available 24 hours per day, 7 days per 
week. Search this online Knowledge Base to find 
answers, to view error messages, to access trou-
bleshooting tips, to download updates, and to 
read or join online message-board discussions.

For support on Pro Tools HD, see “About 
www.digidesign.com” on page 4.

Interplay Access for Avid 
Editing Applications
For detailed information on configuring an Avid 
editing application (such as Media Composer) 
for use with an Avid Interplay environment, see 
the Avid Interplay Best Practices Guide.
Chapter 1: Introduction 3
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Conventions Used in This 
Guide
All Digidesign guides use the following conven-
tions to indicate menu choices and key com-
mands:
:

The following symbols are used to highlight im-
portant information:

Convention Action

File > Save Choose Save from the 
File menu

Control+N Hold down the Control 
key and press the N key

Control-click Hold down the Control 
key and click the mouse 
button

Right-click Click with the right 
mouse button

User Tips are helpful hints for getting the 
most from your Pro Tools system.

Important Notices include information that 
could affect your Pro Tools session data or 
the performance of your Pro Tools system.

Shortcuts show you useful keyboard or 
mouse shortcuts.

Cross References point to related sections in 
this guide or other Pro Tools Guides.
Pro Tools Avid Interplay Guide
About www.digidesign.com
The Digidesign website (www.digidesign.com) is 
your best online source for information to help 
you get the most out of your Pro Tools systems. 
The following are just a few of the services and 
features available. 

Support Contact Digidesign Technical Support 
or Customer Service; download software up-
dates and the latest online manuals; browse the 
compatibility information for system require-
ments; search the online Answerbase or join the 
worldwide Pro Tools community on the Digide-
sign User Conference.

Training and Education Study on your own using 
courses available online or find out how you can 
learn in a classroom setting at a certified 
Pro Tools training center. 

Products and Developers Learn about Digidesign 
products; download demo software or learn 
about our Development Partners and their plug-
ins, applications, and hardware. 

News and Events Get the latest news from 
Digidesign or sign up for a Pro Tools demo.

To learn more about these and other resources 
available from Digidesign, visit the Digidesign 
website (www.digidesign.com). 



                        
chapter 27

Installing Pro Tools with Avid Interplay 
Support
This chapter describes installing and configur-
ing Avid Interplay applications and settings for 
use with Pro Tools.

Overview of Setting Up 
Interplay for Checking In from 
Pro Tools
Installing Pro Tools with Avid Interplay support 
involves these steps, which are necessary to fol-
low in the exact order listed here: 

1  Install Pro Tools: See the HD Getting Started 
Guide.

2  Install Interplay Access on your Pro Tools sys-
tem. After Interplay Access has successfully in-
stalled, install the Pro Tools Interplay Option on 
your Pro Tools system: See “Installing Interplay 
Access and the Pro Tools Interplay Option on a 
Pro Tools System” on page 5.

For detailed information on installing Avid 
Interplay applications and configuring set-
tings for Avid editing applications, see your 
Avid Interplay documentation.
C

3  Optional: Use Interplay Administrator (in-
stalled with Interplay Access) to configure plug-
in settings for Avid sequence exporting and 
Pro Tools importing. See “Configuring the Inter-
play Administrator Export and Import Plug-Ins” 
on page 8.

The Interplay Access and Pro Tools Interplay 
Option installers are available on the Avid Inter-
play Installer DVD. For more information, see 
the Avid Interplay Software Installation and Config-
uration Guide.

Installing Interplay Access and the 
Pro Tools Interplay Option on a 
Pro Tools System

This section describes how to install Avid Inter-
play Access and the Pro Tools Interplay Option 
on a Pro Tools system.

To install Interplay Access and the Pro Tools 
Interplay Option on a Pro Tools system:

1  Insert the Interplay Installer DVD.

You must reinstall the Pro Tools Interplay 
Option each time you update Pro Tools. See 
“Reinstalling the Pro Tools Interplay Op-
tion on Subsequent Updates to Pro Tools” 
on page 7.
hapter 2: Installing Pro Tools with Avid Interplay Support 5
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2  Locate and double-click the Launch.exe in-
staller.

The Main Menu window appears.

3  Click Clients.

The Interplay Install Client Support window ap-
pears. 

4  Click Install Pro Tools Interplay Client.

The Interplay Install Pro Tools Interplay Client 
window appears.

Interplay installer Main Menu window

Interplay Install Client Support window

Interplay Install Pro Tools Interplay Client window
Pro Tools Avid Interplay Guide
5  Install the following components on your 
Pro Tools system.

Avid Interplay Access Installs the Interplay Ac-
cess and Interplay Administrator applications. 

Pro Tools Interplay Option Does the following:

• Copies ProToolsInterplayOption.dll to the 
Pro Tools install folder.

– and –

• Installs two plug-ins—Editor Export Set-
tings for Pro Tools and Pro Tools Import 
Settings—to the Interplay Administrator 
application. 

6  When you are finished with your installa-
tions, click Exit to leave the Installer.

The next time you launch Pro Tools, the follow-
ing menu options are available:

• File > Import > Sequence from Avid Interplay

• File > Export > Selected Tracks to Sequence in 
Avid Interplay

You must install Interplay Access before in-
stalling the Pro Tools Interplay Option.

See the Avid Interplay Software Installation 
and Configuration Guide for detailed infor-
mation.

You can also install the Pro Tools Interplay 
Option on any computer within the Inter-
play system. This is useful if you want to al-
low another Interplay administrator (such 
as an Avid editor) to configure Pro Tools im-
port and export settings.



                        
Reinstalling the Pro Tools 
Interplay Option on Subsequent 
Updates to Pro Tools

The Pro Tools Interplay Option is not retained 
when you update to the next version of 
Pro Tools. The next time you update Pro Tools, 
you must reinstall this option.

About the Pro Tools Check-In 
Folder
By default, the folder structure on the Interplay 
database matches the folder structure within the 
Avid editing application. When an Avid editor 
checks in a sequence to Interplay for Pro Tools, 
the Interplay database stores two separate ver-
sions of the sequence:

• The original sequence (compatible only with 
Avid editing applications) is stored at the fol-
lowing location:

Projects\project_name\bin_name

• A special version of the sequence (known as 
the Pro Tools sequence) is stored in a sub-folder 
called Pro Tools at the following location:

Projects\project_name\bin_name\Pro Tools

The Pro Tools editor will later check out the ver-
sion of the sequence residing in the Pro Tools 
folder.

Avid Interplay Access folder structure

Pro Tools
folder

Project
name

Bin name

Projects
folder
C

Defining the Check-In Destination 
Folder

The Avid editing application selects a check-in 
destination folder according to its Interplay 
Folder settings. 

The Avid editor can use the default settings or 
change them by opening the Interplay Folder 
Settings dialog from the Project window.

Project window (Avid editing application)

Interplay Folder Settings dialog

Interplay 
Folder
settings
hapter 2: Installing Pro Tools with Avid In
terplay Support 7
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Configuring the Interplay 
Administrator Export and 
Import Plug-Ins
The Pro Tools Interplay Option installer adds 
the following plug-ins to the Interplay Adminis-
trator application: 

• Editor Export Settings for Pro Tools

• Pro Tools Import Settings

Configuring these plug-ins is not required, but 
doing so lets you establish a “template” of set-
tings that are automatically applied to se-
quences that are either exported from an Avid 
editing application or imported into Pro Tools.

Configuring Editor Export Settings 
for Pro Tools

The Editor Export Settings for Pro Tools plug-in 
establishes default settings for the Avid editing 
application to use when exporting a sequence to 
Interplay for Pro Tools.

Plug-ins in the Interplay Administrator application

Pro Tools 
Import 

Settings

Editor Export 
Settings for 
Pro Tools
Pro Tools Avid Interplay Guide
An Avid editor (or Interplay administrator) can:

• Configure the Editor Export Settings for 
Pro Tools plug-ins before exporting a se-
quence from the Avid editing system.

– or –

• Wait until they begin the export process (at 
which point the Avid editing application will 
prompt for export settings). 

The Avid editor can establish export settings for 
the entire database or for particular folders. Set-
tings are automatically inherited from the par-
ent folder or project, but can be explicitly mod-
ified by folder.

To configure the Editor Export Settings for 
Pro Tools:

1  In the Interplay Administrator window, dou-
ble-click the Editor Export Settings for Pro Tools 
plug-in to open it.

The following illustration shows the settings for 
a project folder named “PR3 NTSC 30i.” Sub-
folders inherit settings. You can modify the set-
tings for any folder in the hierarchy.

Editor Export Settings for Pro Tools



Video Details

Transcode Video Resolution The Avid editing ap-
plication uses this setting to perform a video 
mixdown when the Video Mixdown option is 
selected after the sequence is checked in to In-
terplay for Pro Tools.

The application might also use the setting when 
you perform a “link to existing media” export. 

Audio Details

Audio Mixdown Specifies whether to include an 
audio mixdown with each export. Available op-
tions are No Mixdown, Stereo, and Mono.

Convert Audio Sample Rate Specifies the audio 
sample rate for the export. The Project option re-
fers to the current audio sample rate setting used 
in the original Avid project.

Convert Audio Bit Depth Specifies the audio bit 
depth for the export. The Project option refers to 
the current audio bit depth setting used in the 
original Avid project. (Dither will automatically 
be applied to any audio with a converted bit 
depth.) 

2  Click Apply.

3  Click the Menu button to return to the Ad-
ministrator window.

For more information, see “Checking In a 
Sequence to Interplay for Pro Tools” on 
page 12.

Changes take effect for the Avid editing ap-
plication the next time the editor logs into 
the Interplay Window. The editor may have 
to log out of the Interplay Window and log 
back in.
C

If Editor Export Settings for Pro Tools 
Are Not Configured

If the Editor Export Settings for the Pro Tools 
plug-in is not configured for a particular folder, 
the Avid editing application displays the 
Pro Tools Export Settings dialog when a se-
quence is checked into Interplay for Pro Tools. 
The Avid editor can specify the settings for that 
particular export in the dialog. 

Configuring Pro Tools Import 
Settings

The Pro Tools Import Settings plug-in estab-
lishes default settings for Pro Tools to use when 
importing a sequence from Interplay. These set-
tings correspond directly to the settings used by 
Pro Tools in the Import Session Data and the 
New Session dialogs. 

Pro Tools Export Settings dialog

See the Pro Tools Reference Guide for de-
tailed information on the Import Session 
Data and New Session dialogs.
hapter 2: Installing Pro Tools with Avid Interplay Support 9
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To configure the Pro Tools Import Settings:

1  In the Interplay Administrator window, dou-
ble-click the Pro Tools Import Settings plug-in 
to open it.
 

Pro Tools Import Settings (entire view)
Pro Tools Avid Interplay Guide
Settings are automatically inherited from the 
parent folder or project, but can be explicitly 
modified by folder. You can also select an indi-
vidual folder and set specific values for that 
folder and its subfolders. 

Pro Tools Import Settings (folder list)

If an administrator did not enter any set-
tings in the Pro Tools folder or any parent 
folder in the hierarchy, the Pro Tools editor 
can modify those settings in the New Ses-
sion or Import Session Data dialogs during 
the import into Pro Tools.

Settings configured for 
the entire database
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Avid Interplay Workflows for Pro Tools and 
Avid Editing Applications
Workflows for using Interplay to pass a se-
quence between an Avid editing application and 
Pro Tools involve the following steps:

1  If the Avid project is in an HD resolution, the 
Avid editor switches the Project Type to an SD 
resolution.

2  The Avid editor checks in a sequence to Inter-
play for Pro Tools.
Chapter 3: Avid Interp
3  The Pro Tools editor imports a sequence from 
Interplay.

4  The Pro Tools editor exports edited and mixed 
audio tracks back to the sequence residing on 
the Interplay server.

5  The Avid editor imports audio tracks back into 
the Avid editing application.
Figure 1.  Diagram of Avid Interplay system

Interplay server
(Interplay
database)

Unity ISIS or 
MediaNetwork
(media storage)

Avid editing 
application

Avid machine

Interplay 
Access

Interplay 
Administrator

Pro Tools with 
the Pro Tools

Interplay Option

Pro Tools machine

Interplay 
Access

Interplay 
Administrator

Administrator machine with Pro Tools 
Interplay Option installed

(Pro Tools not required on this machine)

Interplay 
Access

Interplay 
Administrator
lay Workflows for Pro T
ool
s and Avid Editing Applications 11
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Switching the Project Type for 
HD Projects
Pro Tools HD with an Avid video peripheral can 
import and display editing metadata from HD 
Avid video, but cannot play back or display HD 
video frames. For this reason, sequences ex-
ported from Avid HD projects should also in-
clude a video mixdown in an SD resolution cor-
responding to the original HD resolution. 
Changing the resolution of the video mixdown 
involves changing the project’s Format type.

To change an HD project’s Project Type:

1  Open the Project in the Avid editing applica-
tion.

2  In the Project window, click the Format tab.

3  Choose a corresponding SD resolution from 
the Project Type pop-up menu. For example, in 
an NTSC 1080i/59.94 project, switch to a 30i 
format and in a PAL 1080i/50 project, switch to 
a 25 format.

Project window, Format tab

Only audio files can be exported from 720p 
projects. Because 720p projects have no cor-
responding SD resolution, video files cannot 
be exported from them. 
Pro Tools Avid Interplay Guide
Checking In a Sequence to 
Interplay for Pro Tools
This section describes how to use an Avid edit-
ing application to check in a sequence to Inter-
play for Pro Tools.

To check in a sequence to Interplay for Pro Tools:

1  Navigate to the bin containing the sequence 
you want to export.

2  Do one of the following:

• Select the sequence, and choose File > 
Check In to Interplay for Pro Tools.

– or –

• Right-click the sequence, and choose 
Check In to Interplay for Pro Tools.

Bin containing the sequence to export



If you have previously set the Editor Export Set-
tings for Pro Tools for the folder, the Pro Tools 
Video Mixdown dialog appears.

3  Select one of the following options:

New Video Mixdown Includes a video mixdown 
in the exported sequence using the resolution 
set in the Project Type pop-up menu of the 
project window’s Format tab. This option 
should be selected if the Avid editor is working 
on an HD project. No video effects will be ren-
dered in the project.

Link to Existing Video Media Use this option 
when effects have either been rendered or are 
unnecessary for the Pro Tools editor. (Ensure 
that linked video can be played from the 
Pro Tools system.) With this option, the Avid 
editing application:

• Does not render any effects.

• Determines whether the current resolution 
matches the Transcode resolution in the Edi-
tor Export Settings for Pro Tools plug-in in the 
Interplay Administrator. Depending on 
whether the settings match, one of the follow-
ing occurs:

• If the settings either match or have not 
been created for the check-in folder, the 
system creates a sequence that links to the 
existing media and does not create a video 
mixdown or render any video effects.

Video Mix dialog

See “Configuring Editor Export Settings for 
Pro Tools” on page 8 for information.
Chapter 3: Avid Interp
• If the settings do not match, the system 
transcodes the sequence according to the 
setting in the Export Settings for Pro Tools 
plug-in and links the sequence to this new 
media. The system also renders (or re-ren-
ders) all video effects to match the 
transcode resolution. The application over-
rides the “Link To” option in order to guar-
antee that the Pro Tools editor has access to 
a resolution that is supported by Pro Tools.

4  Click OK to check in the sequence to Interplay 
for Pro Tools.

After Checking In a Sequence to 
Interplay for Pro Tools

The system exports the sequence from the Avid 
editing application, and then checks in the se-
quence to Interplay.

If the Interplay folder containing the exported 
sequence has been configured with video and 
audio settings defined in the Editor Export Set-
tings for Pro Tools plug-in, those settings are ap-
plied to the sequence. (These settings can apply 
to either the entire database or to one or more 
folders, depending on how they are configured.)

When an Avid editor checks in a sequence to In-
terplay for Pro Tools, the system chooses a desti-
nation folder in the Interplay database based on 
the current Interplay view settings, with the de-
fault destination folder as follows:

Projects\project_name\bin_name

See “Configuring Editor Export Settings for 
Pro Tools” on page 8.

For more information, see “About the 
Pro Tools Check-In Folder” on page 7.
lay Workflows for Pro Tools and Avid Editing Applications 13
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If your check-in destination folder is a folder for 
which settings have not been defined, the sys-
tem displays the Pro Tools Export Settings dia-
log so the Avid editor can specify the settings. 

Exported Files in Interplay

If this is the first time the Avid editor has 
checked in a sequence to Interplay for Pro Tools 
for this project, the system performs the follow-
ing operations:

• Checks in the Avid sequence to the bin_name 
folder.

• Creates a Pro Tools folder within the bin_name 
folder.

• Checks in the files for the Pro Tools editor to 
the Pro Tools folder.

• Checks in a Pro Tools sequence to the 
Pro Tools folder.

Pro Tools Export Settings dialog

Location of the Avid sequence and its associated 
Pro Tools directory

The name matches the name in the 
Avid editing application bin
Pro Tools Avid Interplay Guide
The first time the sequence is exported, the sys-
tem appends the text “_v1_forPT” to the se-
quence name in the Pro Tools folder. Each sub-
sequent time the sequence is exported, it uses 
the text “_v2_forPT,” “_v3_forPT,” and so on.

The following illustration shows the contents of 
the Pro Tools directory after the first export.

Contents of Pro Tools directory (left pane) and 
sequence listed in that directory (right pane)

The red dots in the illustration indicate that 
the system has placed a reservation on the 
files to prevent unauthorized deletion for a 
fixed period of time. For more information, 
see the Avid Interplay Access User’s Guide.

Red dots “_v1_forPT” appended to the 
sequence name



Importing a Sequence into 
Pro Tools from Interplay
This section describes how to locate a sequence 
on the Interplay database and import it into 
Pro Tools. This section assumes that you have 
already configured the Pro Tools Import settings 
in the Interplay Administration tool. 

If you do not establish Pro Tools Import Settings 
before importing the sequence into Pro Tools, 
you can select the appropriate values in the Im-
port Session Data dialog during the import pro-
cess.

When importing a sequence from Interplay into 
Pro Tools, you can import into a new or existing 
session. 

Importing a Sequence into 
Pro Tools from within Interplay

To check out the sequence and import it into 
Pro Tools from within Avid Interplay Access:

1  Start Avid Interplay Access.

2  Navigate to the Pro Tools folder containing 
the sequence you want to import.

For more information, see “Configuring 
Pro Tools Import Settings” on page 9.

Navigating to the sequence
Chapter 3: Avid Interp
3  Right-click the sequence, and choose Import 
to Digidesign Pro Tools.

If Pro Tools is not already running, it automati-
cally launches.

Importing a Sequence from 
Interplay from within Pro Tools

This section describes to how to use Pro Tools to 
import a sequence from Interplay. If you have 
not yet opened Interplay Access and specified a 
server to connect to, you must do that before 
performing this procedure. 

Importing a sequence into Pro Tools from within Access

See “Importing a Sequence into Pro Tools 
from within Interplay” on page 15 for de-
tailed information.
lay Workflows for Pro Tools and Avid Editing Applications 15
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To check out the sequence and import it into 
Pro Tools from within Pro Tools:

1  Start Pro Tools.

2  If you want to import the sequence into an ex-
isting session, open that session.

3  Choose File > Import > Sequence from Avid 
Interplay.

The Interplay Engine Browser appears.

4  In the Interplay Engine Browser, expand the 
Interplay database by clicking the plus sign (+) 
next to it.

5  Expand the root folder of the database—usu-
ally titled AvidWG or a variation thereof—by 
clicking the plus sign (+) next to its name. 

6  Expand the Projects folder.

7  Expand the project containing the sequence 
you want to check out and import to Pro Tools.

The Logon to Interplay dialog appears.

Interplay Engine Browser

The folder structure matches the structure in 
Interplay Access.

Interplay
database
Pro Tools Avid Interplay Guide
8  Enter your username and password, and click 
OK.

9  In the Interplay Engine Browser, locate and se-
lect the sequence that you want to import.

10  Click OK. 

Logon to Interplay dialog

Interplay Engine Browser (folder structure displayed)

Files that appear in greyed out text out are 
not available for import into Pro Tools.



11  If the Name the Session dialog appears, nav-
igate to the appropriate location either on local 
storage or on a dedicated Unity workspace, and 
click Save.

Name the Session dialog

This dialog does not appear if you are im-
porting a sequence into an existing session.
Chapter 3: Avid Interp
12  If the Pro Tools Import Session Data dialog 
appears, select the appropriate options and click 
OK.

Import Session Data dialog

This dialog does not appear if you config-
ured the Pro Tools Import Settings in the 
Avid Interplay Administrator. Pro Tools au-
tomatically uses those settings to import the 
sequence. (See “Configuring Pro Tools Im-
port Settings” on page 9 for detailed infor-
mation on configuring Pro Tools Import Set-
tings, and the DigiTranslator Guide for 
detailed information on setting options in 
this dialog.)
lay Workflows for Pro Tools and Avid Editing Applications 17
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Pro Tools imports the sequence, copies any me-
dia (if the settings require copying), and displays 
the imported sequence within the Pro Tools ses-
sion. 

If the sequence was linked to media files on 
unmounted volumes, the system provides a 
warning and asks you to mount those vol-
umes before you proceed with copying or 
linking to media.

Sequence imported from Interplay into the Timeline
Pro Tools Avid Interplay Guide
Exporting Edited Audio Tracks 
to Interplay from Pro Tools
After you edit the audio material from the se-
quence, you can export the audio tracks back 
into the sequence in Interplay.

To export audio tracks from Pro Tools, and then 
check in audio tracks to Interplay:

1  In Pro Tools, select the tracks that you want to 
export into the Pro Tools sequence on Interplay.

2  Select File > Export > Selected Tracks to Se-
quence in Avid Interplay.

3  In the Export Comment dialog, type a com-
ment and click OK.

4  In the Replace or Add Selected Tracks dialog, 
select a method for laying back edited audio ma-
terial into the Pro Tools sequence residing on 
the Interplay server:

Replace with Selected Tracks Replaces the old 
audio tracks in the Pro Tools sequence with the 
edited audio tracks. Select this option if you do 
not want to preserve the original audio in the se-
quence. 

Only audio tracks that originated as part 
part of a sequence on Interplay may be ex-
ported back into Interplay.

It is recommended that you provide com-
pleted audio stems rather than audio tracks 
with edits.

Export Comment dialog



Add Selected Tracks Adds the edited audio 
tracks to the Pro Tools sequence on the Inter-
play database. Select this option if you want to 
preserve the original audio in the sequence.

5  Click OK.

A confirmation message box appears.

6  Click OK.

The sequence in the Avid Interplay database is 
now ready to be checked out and imported by 
the Avid editor.

When adding selected tracks, ensure that 
the total number of tracks in the sequence 
residing on the Interplay server does not ex-
ceed 24—the total allowed number of 
tracks for the Avid editing application. Con-
tact the Avid editor or consult Avid docu-
mentation for information on the total 
number of tracks allowed.

Replace or Add Selected Tracks
Chapter 3: Avid Interp
Importing Pro Tools Audio 
Files Back into the Avid 
Editing Application
After you have checked out the completed audio 
stems to the Pro Tools sequence on the Interplay 
server, the Avid editor imports the sequence 
back into the Avid editing application.

To import the sequence back into the Avid editing 
application:

1  In the Avid editing application, open the In-
terplay Window and navigate to the location of 
the checked in Pro Tools sequence.

2  Drag the sequence into the bin.

Interplay browser

Depending on edits made in Pro Tools, you 
might see several audio files with names 
containing the prefix “Sample accurate 
edit.” For more information, see “Frame-
Rate Accurate Video Editing and Sample-
Rate Accurate Audio Editing” on page 20.

Pro Tools folder Files checked in by 
the Pro Tools editor
la
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The Avid editing application checks out the se-
quence and imports it and its related files into 
the bin.

3  The Avid editor can do one of the following: 

• Add the new audio tracks into the original 
sequence.

– or –

• Work with the imported sequence.

In this example, the Pro Tools audio tracks are 
added into the original sequence.

4  Load the imported sequence into the Source 
monitor.

5  Add the audio into the original sequence us-
ing standard editing techniques. 

Bin after import

If you plan to check in the sequence to Inter-
play for Pro Tools again, it is simpler to im-
port the audio into the original sequence. 
Every time you export a sequence for 
Pro Tools, the system appends the text 
“_vx_forPT,” where x is the number of 
times the sequence has been exported. It can 
become confusing if several similar text 
strings are appended to the name.

For more information, see the documenta-
tion (PDF or Help file) for your Avid editing 
application.

Imported
sequence

Video mixdown
created during

first check in to
Interplay

Original
sequence
Pro Tools Avid Interplay Guide
The following illustration shows the audio 
tracks cut into the original sequence. In this ex-
ample, the original tracks are overwritten. 

6  Now the Avid editor can make any adjust-
ments to the sequence and do the following:

• Create a digital cut.

• Perform a Send to Playout operation.

• Check in the sequence to Interplay for 
Pro Tools if the Pro Tools editor needs to 
work on the sequence again.

Frame-Rate Accurate Video 
Editing and Sample-Rate Accurate 
Audio Editing

After a sequence has been exported back to In-
terplay from Pro Tools, a number of additional 
media files appear in the Interplay Window and 
in the bin. Some have names containing the 
prefix Sample accurate edit. These are the addi-
tional media files that Pro Tools creates to make 
sure that the Avid editing application receives 
frame-accurate audio. Sample-accurate edit me-
dia files are visible if you zoom in on portions of 
the imported audio in the Timeline.

Sequence in the Avid Timeline after overwrite



The following illustration shows Sample accu-
rate edit files in the Interplay Window.

Avid video editing applications edit with frame 
accuracy. This means that in a 30-fps project, 
the Avid editor can edit at 30 different locations 
for every one second of video. Pro Tools edits 
with sample rate accuracy. In a 48 kHz session, 
there are potentially 48,000 locations to edit for 
every second of audio. 

Sample-accurate edits in the Interplay window

Sample-accurate 
edit audio files
Chapter 3: Avid Interp
When Pro Tools exports a sequence, it must en-
sure that the audio media files line up on frame 
boundaries. To do this, it might have to split an 
existing audio clip into three clips. For example, 
the following illustration shows a 5-frame video 
clip and a corresponding audio clip. In 
Pro Tools, the audio clips might not line up on 
video frame boundaries.

In order to export frame accurate audio clips, 
Pro Tools splits the audio media on frame 
boundaries and fills any gaps with silence. The 
following illustration shows the resulting audio 
clips that are exported to the Avid editing appli-
cation.

To cut down on the number of sample accurate 
edit files, the Pro Tools editor can perform a 
Bounce to disk for each track (or a bus-record to 
an audio track) rather than exporting tracks that 
contain all of the audio edits. 

The original audio clip does not line up on video frame 
boundaries

Exported audio clips line up on video frame boundaries

1 Pro Tools
audio clip

5 frame
video clip

3 exported
audio clips

5 frame
video clip

New audio clips with 
padded silence
la
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Exporting a Sequence from 
Avid Interplay Access as an 
AAF Sequence to Any Volume
This section describes how to export a sequence 
residing on the Interplay server as an AAF file, 
and save it to any volume.

This is especially useful if the Avid editor has 
checked in an updated version of a sequence 
you are already working on in Pro Tools, and 
you want to use a third-party re-conform tool to 
reconcile the edits between the different ver-
sions of that sequence within your session. 

To export a checked-in sequence as an AAF 
sequence:

1  Start Avid Interplay Access.

2  Navigate to the folder containing the se-
quence that represents the same version of the 
sequence you have already started working with 
in Pro Tools. 

3  Right-click this original sequence, and choose 
Export Selected Sequence as AAF.

4  Navigate to a location on a volume where you 
want to save the sequence. This should be a vol-
ume and location easily accessible from your 
Pro Tools system. Click OK.

5  Navigate to the Access folder containing the 
version of the same sequence that was most re-
cently checked in by the Avid editor.

6  Right-click this updated sequence, and choose 
Export Selected Sequence as AAF.

7  Navigate to the same location where you 
saved the original sequence, and click OK.

8  Use a third-party post-production re-conform 
tool to re-conform your Pro Tools session to the 
new picture edit.
Pro Tools Avid Interplay Guide
Version Control Between the 
Avid Video Editor and 
Pro Tools Editor

The First Round Trip Check In

The first time an Avid editor checks in a se-
quence to Interplay for Pro Tools, the following 
occurs:

• The system checks in the sequence to the cor-
responding folder in Interplay (by default, the 
Project\project_name\bin_name folder).

• The system creates a Pro Tools folder in the 
same directory and checks in the following 
file to that folder:

• Sequence_name_v1_forPT

The Pro Tools editor checks out the sequence 
called Sequence_name_v1_forPT. After the 
Pro Tools editor completes the audio editing, 
they export selected tracks back into the se-
quence at the same location.

The following illustration shows the sequence 
in Interplay Access. The sequence name does 
not change when checked in to Interplay.

Interplay Access folder list (left) and sequence (right)

Sequence
checked in

from Avid video
editor main-

tains original
name

Main project folder



The following illustrations depict the sequence 
in Avid Interplay Access after the Pro Tools edi-
tor has done the following:

• Imported the Pro Tools sequence to a session 
inside Pro Tools

• Edited and mixed audio

• Exported selected tracks back to the Pro Tools 
sequence on Interplay

Two versions of the sequence are now available.

To open the History window for a file in Interplay 
Access:

� Right-click the sequence, and choose Version 
Control > History.

Interplay Access folder list (left) and sequence (right)

Version History dialog

Sequence for
Pro Tools

editor

Pro Tools folder
Chapter 3: Avid Interp
At this point the Avid video editor can check out 
sequence_name_v1_forPT and either edit the se-
quence directly or cut the audio back into the 
original sequence. 

Subsequent Check Ins from the 
Avid Editor and the Pro Tools 
Editor

Each time the Avid editor checks in a sequence 
to Interplay for Pro Tools, the following occurs:

• The sequence_name sequence in the corre-
sponding bin folder in Interplay is updated 
with a new version. The file name does not 
change.

• The Avid editing system creates a new file for 
the Pro Tools folder and changes the 
vx_for_PT portion of the name.

In the following example, the Avid editor does 
the following:

1  Checks out the sequence called 
sequence_name_v1_forPT, and cuts the new au-
dio into the original sequence.

2  Checks in the version of the sequence with 
the updated audio files to Interplay without 
making any additional changes. 

3  Makes additional changes to the video and 
checks in the sequence back to Interplay so that 
the Pro Tools editor can make additional audio 
changes.

For more information, see “Importing 
Pro Tools Audio Files Back into the Avid 
Editing Application” on page 19.
lay Workflows for Pro Tools and Avid Editing Applications 23
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The following illustration shows the exported 
video sequence in Interplay Access along with a 
version history of the sequence. There are now 
three versions of the sequence in Interplay.

The following illustration shows the sequences 
in the Pro Tools folder after the sequence has 
been checked in three times by the Avid editor. 
The illustration also shows the version history of 
one of the sequences.

Version History dialog

Version history of one sequence

Two versions of the version 1 
sequence checked in by the 

Pro Tools editor

Three Pro Tools sequences, 
one for each check in from the 

Avid video editor
Pro Tools Avid Interplay Guide
Keeping Track of the Versions

After numerous check ins and check outs (even 
with one sequence), it can be complicated to 
keep track of the individual files in the Pro Tools 
folder. It is important that the Avid and 
Pro Tools users communicate with each other 
regarding when files are ready and which file 
should be worked on next. Most of the time, you 
would work on the latest version.

In order to speed up communication, you can 
use the e-mail Messenger service available in In-
terplay Access. 

To send e-mail notification about a sequence:

1  Launch Avid Interplay Access, and navigate to 
the sequence for which you want to send a no-
tification. 

2  Choose Messenger > Send Link To.

Interplay Administrator can be used to en-
able e-mail notification for Interplay (and 
set up individual users to receive these noti-
fications). For details, see the Avid Interplay 
Engine and Avid Interplay Access Adminis-
tration Guide. 

Sending e-mail notification about a sequence



The e-mail notification window appears with a 
link to the sequence. 

3  Fill in the information and click Send. The re-
cipient receives an e-mail message containing a 
link to the file and any additional information.

Messenger window
Chapter 3: Avid Interp
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